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Congratulations to WAUC member,
Norval “Red” Adams, on his induction into
the Southeastern Wisconsin Short Track
Hall of Fame on November 5th, 2011. Red
has raced modifies, stock cars, and late
models. He mostly raced locally at Slinger,
Cedarburg, Wisconsin State Fair Park and
Hales Corners. He has also raced at Wilmot, Franksville, in Pennsylvania, in Ohio,
and in Chicago and southern Illinois. He
raced in the first and the last race at Hales
Corners.
We congratulate Red on his many years of
racing and his induction into the Hall of
Fame.

WAUC Holiday Party
Thursday, December 1
Hot beef and turkey sandwiches, soda and
paper products provided.
Offering of one dollar requested
to defer costs.
Great food, singing, games
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President’s Message—Two
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Biographies Published

Another year is
nearly at an end.
2011 has been a
year of changes
both good and bad.
We lost a genius
when Steve Jobs
passed away on
October 5th. As I
write this message the movie “Steve
Jobs—the Lost Interview” is being
shown at the Landmark Oriental
Theater.

Man” and “Steve Jobs, an authorized
biography.” On October 14th Apple
released its latest bit of technology,
the iPhone 4S with improved video
recording, faster graphics, and a
voice recognition system called Siri.

Two noteworthy biographies came
out this year. “Paul Allen—Idea

The Excel SIG continues to draw
members eager for knowledge of the

WAUC had a good year also. We
have had many good speakers, including Len Levine and Joe Schoen.
We also lost some members through
their passing: Glenn Ehnert and
Richard Schmidt.

Board Meeting—Future
On October 27,
2011, Bruce Kosbab, Doris Regner,
Terry Harvey, Tom
Hermann, and Bill
Gierach gathered at
Doris’s home for
the October 2011

Doris made a beautiful sympathy
card for us all to sign for the family of
Richard Schmit. We all mourn the
loss of Richard. He was a long time
WAUC member along with his wife
Lorraine and his daughter Elaine.

It has truly been a good year and I
look forward to a blessed 2012.
Thanks to all who made the year a
good one and have a Happy holiday
season.

Bruce Kosbab
President

Brings New Role for Terry

We went over the details of the Annual WAUC Christmas Party. We will
have turkey and gravy sandwiches
and beef and gravy sandwiches. The
club will also furnish the soda, coffee, and paper products. Each person attending will be asked to pay $1
and to bring a dish to pass.

Board Meeting.
Doris gave each of us a copy of next
year’s color coded calendar. Each
one of us went over the calendar
with a fine tooth comb looking for
errors. Doris did a fabulous job; we
found only one error.

popular program and the Investment
SIG continues to help us learn more
about the ups and downs of the
stock market.

I mentioned that with so many people having Windows 7 that perhaps
it’s time to get a new laptop. I have
been seeing ads for $299 for a Toshiba Satellite with 4GB of RAM and
320GB hard drive. I have the same
laptop they are advertising and I’m
very happy with it, even though I paid
$400 for it. We decided Bill would
start shopping for a new laptop and
we would ask the membership to
vote on it. The price was not to exceed $500. Bill is a great shopper;
we are confident he will get us the
best bang for our buck.
New board member Richard Durand,
again asked if a general synopsis of
the SIGs could be given at each
General Meeting. It was agreed that
if more members were aware of what
was accomplished at each SIG that it
might draw more members to attend
them.
As my term is counting down I would
like all WAUC members to know that
I have truly enjoyed each and every
one of them and I don’t want to lose

contact with anyone.

Terry Harvey
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General Meeting—Discussion
President Bruce
Kosbab welcomed
thirty-eight members to the November meeting.
Bruce announced
the sad news of the
death of long-time
member Richard
Schmit this past month, and recalled
the death of another faithful member,
Glen Ehnert, which was announced
previously.

WAUCtalk

of New Club Laptop

Holiday Party: There was a sign-up
sheet for bringing dishes to pass at
the December Holiday Party on December 1st. WAUC will provide
sandwiches and beverages.
New Computer: WAUC will be in
need of a new computer in the near
future. Since it is an expense of or
exceeding $500.00, approval must
come from the membership. Richard
Durand made a motion that WAUC
purchase a new laptop not to exceed
$500.00; Marcia Zientek seconded

SIG (Special Interest Group) Reports: Ginny Splinter showed us how
she gathered her data for her class
reunion as a Word document and
commended Julia, our WAUCtalk
editor, for being able to insert Excel
files into a Publisher document.
Ginny gave us a preview of what
members will learn at the next Excel
SIG on November 10th.

ship in APCUG (Association of Personal Computer User Groups) for
2012 at $50. Julia mentioned APCUG’s first virtual conference that
will be held on November 12th. She
wrote an article in the November
WAUCtalk and hoped some members would join the conference.
Raffle: Leo said that we have a USB
charger and batteries, a 4gig flash
drive and a smart webcam. The special raffle that costs $5.00 per ticket
is for a terabyte external hard drive.
Besides items for sale, Leo wanted
to have a private raffle for his laptop.
The membership decided that personal items should not be raffled.
CD of the Month: Bill Gierach told us
about the interesting programs he
compiled on this month’s CD of the
Month.
Ginny was disappointed that WAUC
passed up a great opportunity to
have Joe the Computer Guy as a
steady presenter because of a
scheduling conflict. Joe said he
would no longer make presentations
at WAUC meetings.

Julia Rice said that the Mac users
are making a transition from the
SnowLeopard to the Lion operating
systems, with step by step tutorials.
She also recalled Steve Jobs with a
TV program and a book just released.

Presentation
Richard Durand reported on the various techniques the Investment Board
uses in researching stocks and encouraged anyone interested in tracking their investments to attend.
Bruce introduced two new board
members that will be coming onboard. Chuck Bonack will be taking
the minutes and Richard Durand was
at the last Board Meeting to become
familiar with his duties.
Bruce thanked outgoing Board member Terry Harvey for the dedicated
service she performed for so many
years. Julia interjected that it was
Terry who made her feel welcome at
the first meeting she attended which
resulted in her decision to join
WAUC. Julia hopes that the current
Board continues to exhibit that welcoming feeling. Other members affirmed her praise of Terry.

the motion. Discussion following the
motion included making sure the laptop would have enough memory to
satisfy Windows 7; the disposal of
our present computer (probably a
raffle); Milwaukee PC has a very reasonable computer, which didn’t seem
satisfactory to Bill Gierach; unrest in
Malaysia, the source of much of our
electronic equipment and parts which
might affect the cost of computers.
The motion was carried unanimously. Bill Gierach will be in
charge of shopping for a suitable
computer.
Treasurer’s Report: Tom Hermann
gave the Treasurer’s Report. There
were no questions, but answered a
member’s question whether WAUC
had enough money to purchase a
new computer.
WAUC will again renew its member-

Josh Sopczak was a presenter a few
years ago and we welcomed him
again to show us how to network a
printer using our wireless systems,
even though the printer is not wireless.
As long as the USB from the printer
is connected to your computer’s hard
drive, and your main computer is
turned on, you can connect your
printer to another home computer.
After going into your control panel
and selecting Printers and Faxes,
select Add a printer from the Printer
Tasks menu that pops up. Click on
Next in the Wizard and select Local
printer attached to this computer.
After clicking Next, and your computer is unable to locate any Plug
and Play printers, click Next to install
the printer manually. From the scroll
-down menu, locate your Manufac(Continued on page 4)
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Mac SIG—Group
Ray Jamroze, Nancy
Setloch, and Julia
Rice met for the Mac
SIG on November 9.
Nancy brought her
new Mac Air, a new
version of the Mac
for our SIG. One
needed accessory is
a backup hard drive. Ray suggested
My Passport, which should be the
same size as the computer’s hard
drive.
We continued with the MacU introduction to the Lion operating system.
The first feature we say was Stacks,
which operates from the dock. It is a
way to see the contents of a folder.
Files within a folder can be sorted in
various ways. The display can also
be adjusted with various menu items.
The arrangement can be a fan, a grid
or a list. One can sort by, display as
or view as. Usually one sorts by
name, but there are other choices.
The display can be as a stack or a
folder. If you choose automatic display, a short list appears as a fan,
more as a grid. This is the same as
in Lion as it was in Snow Leopard.
The Home Folder is where files that
you make are stored. There is one
for each user account, when several
users have access to the computer.
There is also a shared folder to be
used by all users. To get to the home
and shared folders use the hard
drive display on desktop. Library and
System files never need to be
touched. The seven folders should
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Reviews Old Desktop, Sees Lion OS
not be changed or added to. The
desktop folder is one. Documents is
the next. Downloads keeps all
downloads and is a new addition.
There are a Movies folder and a Music folder. It is best to keep your recorded musis in iTunes. Garage
Band is another part of Music. Keeping photos in iPhoto is the best way
to deal with photos you do not want
to keep; they are easier to move to
trash. There is a Public folder. The
Dropbox folder can also to share
files. One can find recent files from
Go command in a dropdown menu.
The lessons under Files and Folders
included moving, use of the right
click to Move to Trash and how to
create a new folder. There is a keyboard shortcut for making a new
folder. Files and folder are easy to
name. Multiple files can be picked
up by holding the shift key, random
files by holding the command key. A
new folder can be made for such a
selection. Undo is in the menu.
Launchpad is new in Lion. Carried
over from iPhone and iPad, it organizes and opens apps on the Mac. A
folder can be created by dragging
one folder over another. Programs
and utilities have access to Launchpad too. It is easy to get out of the
Launchpad, when it seems to clutter
the desktop.
Disc burning is easy on the Mac.
First create a burn folder: File, Burn
Folder. Alias copies of the items to
be burned are placed in the folder so

that the original is safe. Insert a
blank disc. Open the application that
has the data to be burned. OR drag
and drop items you want to burn onto
the disc folder. It also can turn into a
burn icon.
We talked about the need to back up
in order to install Lion. Ray suggested putting photos on a flash
drive rather than CD for backup.
Spotlight search is always in the top
right corner of the desktop. It is used
to find a file that you know a name
for. It can be used to locate, launch
apps, make calculations (Enter the
problem in the spotlight and it will do
the calculation.)and find a definition.
Now you can extend the search beyond your own hard drive. It will
even connect with Wikipedia. For a
more detailed search, hit the plus
and give parameters. You can create a smart folder that will allow you
later to locate the files listed.
Next we went to Firefox to see what
the latest version is. Julia’s computer immediately began to update to
the latest version which is 8.0. We
all updated Firefox. We recommended that Nancy install Sophos,
the antivirus for the Mac. Ray mentioned that Paypal is the most secure
way to pay for things on the Internet
Ray gave us a concluding piece of
wisdom: The best way to learn on
the computer is to fiddle around.

Julia Rice

General Meeting Cont’d—Presentation on Wireless Printers
(Continued from page 3)

turer and the kind of printer and then
continue following the prompts to
finish the installation.
If you have a wireless printer the settings for networking are on the front
panel of the printer. The advantage
of having a wireless printer is that
your main computer does not have to
be turned on for your other computer

to print to it.
Josh recommends using only one
printer for economic reasons, eliminating the need to supply ink to more
than one printer, which can be rather
costly. He just purchased an Epson
printer that has separate cartridges
for black and colors. He feels that is
an advantage to having to purchase
an entire cartridge with all the colors,

since some colors get used up at
different rates.
We thank Josh for a very practical
presentation in making our computers and printers work more efficiently.

Marcia Zientek

December 2011

Page 5

WAUCtalk

MS Excel SIG—Studies Charts, Graphs
The following nine
people attended the
Microsoft (MS) Excel
2007 SIG on Thursday, November 10:
Lisa Fettig and her
dad Gary Salatnik,
Jody Trinkle, new
members Dick and Kay Yezek, Richard Durand, Bill Gierach, Don Gardner, and Ginny Splinter. We continued our TeachUComp tutorial. Although some attendees have created
a few charts, no one is heavily into
charting.
Chapter 20 - Editing & Formatting
Charts
Creating Basic Chart - After selecting the data to chart (including column names), select the Insert tab,
the type of chart, and sub-chart you
desire. Then select OK. You will get
a basic chart.
Chart Elements List - A chart is a
complex object. Depending upon the
type of chart, the chart elements may
consist of Chart Area, Plot Area,
Chart Title, Axes Titles, Legend,
Data Labels, Data Table, Axes, and
Gridlines.
Chart Tools - 3 Contextual Tabs After creating a chart, you will get
chart tools consisting of three contextual tabs: Design, Layout, and
Format.
Moving/Resizing Charts - You can
resize a chart by selecting the entire
chart. Then move the 4 arrows on
the 4 sides and/or the 4 arrows in the
4 corners to resize the chart. To
move the chart, in the Design tab
and the Location group, select Move
Chart. In the Move Chart dialog box,
select New Sheet and give the new
Excel worksheet a name (or select
“object in” and which name), and OK.
Changing The Data Range - This is
a complex topic for changing, adding, and/or deleting data ranges. In
the Design tab, and Data group, select Data. In the Data Source dialog
box, indicate the changes you want.
Also, indicate your choice for hidden

and empty cells.
Switching Column And Row Data
– To switch the column and row
data, in the Design tab and Data
group, select Switch Row/Column.
Choosing A Chart Layout - To select a chart layout, in the Design tab
and Chart Layouts group, select a
specific chart for a desired chart
type.
Choosing A Chart Style - To select
a chart style, in the Design tab and
the Chart Styles group, select a desired chart style.

your chart is on a separate worksheet, select the worksheet, rightclick, and Delete.
Chapter 21 – Editing & Formatting
Charts
Formatting Chart Objects - Select a
specific chart object. In the Layout
tab, and Current Selection group,
select Format Selection. You will get
a new window with choices depending upon the selected chart object.
When finished, select Close.
Restore Chart Format -After you
make format changes to a chart’s
basic style, you can return to the
original setting. In the Layout tab and
Current Selection group, select Reset to Match Style.
Inserting Pic Into A Chart - To insert a picture into a chart, in the Layout tab and Insert group, select Pictures. Then locate the desired picture
on your computer.

Printing Non-Embedded Chart - If
the chart is not embedded with data,
select the chart. Then select the Office symbol (in the upper left corner),
Print, and Print Preview; review your
chart before printing.
Printing Embedded Chart - If your
chart is imbedded with the data, select a data cell. Then select the Office symbol (in the upper left corner),
Print, and Print Preview; review your
chart before printing.
Deleting Embedded Chart – To
delete an embedded chart with data,
select the Chart Area, and press the
Delete key on the keyboard.
Deleting Non-Embedded Chart - If

Insert Shape Into A Chart - To inset
a shape into a chart, in the Layout
tab and Insert group, select Shapes.
Then select your desired shape.
Insert Text Box Into A Chart – To
insert a text box into a chart, in the
Layout tab and Insert group, select
Text Box. Click and drag over the
area you want to insert the text box.
Then enter your text.
Practicing With Fictional Class
Examples
We stopped after section 21.2 on
Inserting Objects Into A Chart, and
practiced creating charts. We used
fictional sales data for persons selling widgets. We had January through
March monthly sales and quarterly
sales. See Example 1 for the North
region monthly sales.

Example 1-Sales Data

(Continued on page 6)
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(Continued from page 5)

paper to see how it looks.

Example 2 is a basic pie chart of
January sales.

NOTE: It is important to note that the
ink is different in various brand printers. Each brand printer prints the
same color differently.
Dick Example #2 - IBM Mainframe
History
The next Excel chart was on the history of IBM mainframe systems from
1952 through 2010. For many of us,
this was a walk down memory lane.
The 1950s had 650 through 702, and
1401 family. I remember learning
how to code in Autocoder for the
1401.

Example 3 is a column chart of January sales with bars and a colored
background.

Example 4 is a column chart of Quarter 1 sales using Column Chart Style
1.

The 1960s continued with the same
mainframes plus System 360. I remember finally returning to the highlevel FORTRAN & BASIC programming languages with OS. I also
learned a low-level programming
language BAL (Basic Assembly Language). The 1970s had System 370.
I remember batch programming in
OS/MFT (Multiple programming with
a Fixed number of Tasks) and OS/
MVT (Multiple programming with a
Variable number of Tasks) and then
VM/CMS (Virtual Machine/
Conversational Monitor System – a
time sharing operating system) and
later MVS/TSO (Multiple Virtual Storage/Time Sharing Option).
The 1990s continued with System
390. The 2000s began with Z900,
Z9, Z10, Z196, and 2458 family.
Mainframe execution speeds were in
nanoseconds (10-9), picoseconds (10
-12)
), and femtoseconds (10-15). Mainframes were sold in million instructions per second. Now they are sold

Example 5 is a column chart with 3
months of data plus objects and text
boxes.
Dick Example #1- Excel Colors
In the last 30 minutes, we viewed
Dick’s Excel charts. His first example
was on Excel 2003 standard colors
versus Excel 2007 standard colors.
We could see how the standard colors have changed. Excel colors are
also varied by Windows 7. Dick recommended printing a color chart on
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in billion instructions per second.
Stock trading and banking transactions are done on mainframe computers.
Dick - Other Examples
Dick also showed us other Excel
charts. In one chart, he pointed out
that he entered daily a.m. and p.m.
info in different columns on the same
row. When he charted it in a column
chart, the 2 numbers were stacked
on top of each other. Dick changed
the entries for daily a.m. and p.m.
info into two separate rows. Then
each value was charted as a separate column.
Dick had a slight problem in merging
a lot of info into one large worksheet.
We worked on this to find the problem. After you have selected a troubled cell, in the Formulas tab and
Formula Auditing group, select Trace
Precedents. We did this for a few
cells. Then the problem was indicated and could be corrected. This
can often happen with complex accumulated info.
Dick also showed us other charts,
including mainframe capacity planning. We learned a lot from Dick’s
charts.
Next Month - In December we will
finish Chapter 21 on Editing and Formatting Charts and begin Chapter 22
on Pivot Tables. See you at exciting
Excel SIG.

Ginny Splinter
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Internet SIG—Queries
The WAUC Internet SIG was held
again on October 20th. Ten WAUC
members were present. A lot of computer user issues were dealt with. As
we began, Bill Gierach was
downloading and installing he latest
version of the Firefox web browser.
He checked the download speed and
it was at only 115 Kbps. He then
went to our standard Internet speed
testing website, www.speakeasy.net/
speedtest/ and found we were getting only an Internet download speed
of .36 Mbps. Usually it’s much faster.
Firefox finished downloading and Bill
installed it right over the previous
version.
Richard Durand asked why the text
on a website sometimes overlaps
other text on the same site. Bill said
to reboot if this happens and if text
overlap is still present, it is probably
the webmaster’s fault. One can then
try copying and pasting the website
text into a word processor program.

on Download Speed, Email

parently was for a version of Microsoft Office to go along with the Microsoft “XP” operating system. None of
us were familiar with it. Opening a
sample file shows what Ted means.
It’s almost like looking at some ancient hieroglyphics.
Bill demonstrated saving a web page
as a text file or html file. The code is
still present but at least the page can
be read. Ted’s external drive also
had a .xps document reader application, which can be set as the default
printer. Richard Durand asked if Microsoft Office can open files generated with Star Office, Open Office, or
Office Libre, specifically files with the
“.odt” extension. Bill found a file with
this extension and opened it up in
Microsoft Office 2007, so yes, it can
be done. Star Office can also export
files to the popular .pdf file type.
At this point, Bill took the opportunity
to explain the necessity to properly

Richard also asked why the links on
the Yahoo website take so long to
load. It’s because Yahoo has so
much advertising. Try using the Firefox web browser with the Ad-Blocker
Add-On. Bill demonstrated it: the
browser opens up the Yahoo site
with bare areas where the advertising would appear.
Then Bill showed the Yahoo web
page with the Ad-Blocker disabled.
Loading is noticeably slower. Even if
one does not mind seeing it, advertising can really slow down a web
page. Bill also mentioned that the
new Yahoo web mail format does not
allow opening emails in a separate
tab of the browser, a big step backward.
Ted Torkelsen downloads and saves
web pages of news reports to print
them later but upon opening up
these files, they are filled with some
kind of computer code. Ted had
brought along his external hard drive
with some of these saved files and
Bill connected it to the club laptop.
The files are saved in a format with
the “.xps” file extension, which ap-

WAUCtalk

eject external hard drives and flash
drives. The best way is to use an
ejection program written for this purpose, such as the one available on
the WAUC CD of the Month.
Tom Hermann uses Outlook Express
for email and asked how to save
emails to a CD-ROM. Bill first tried
using the “Export” function on the file
menu of Outlook Express but this is
useful only for single emails and Tom
has multiple emails to save. Apparently then, emails have to be saved
one at a time, but then they can all
be saved to the same folder. Open
up a burning program such as Nero
or “CDBurnerXP,” available on the
WAUC CD of the month. Bill showed

how to drag and drop email files or
folders to be copied to a CD ROM on
this program. However the burning
process could not be demonstrated
as we did not have a blank disk.
Dick Reinhard is running Avast as
his anti-virus program and asked
what to do when the program offers
options for an infected FedEx bulletin
file. The best choice is to delete the
infected file. One can keep the infected file by selecting the choice for
placing it in a safe location known as
a “Virus Chest.” After doing so, be
sure to find the latest updates for the
anti-virus program and run a full system scan to make sure the infected
file is no longer present. And then it
would not hurt to run a spyware program also.
Bill was showing something in Adobe
when the window started tiling uncontrollably. The good old key command of “Control-Alt-Delete” was
used to open up the Task Manager
but this did not respond either. Bill
had to hold down the power button to
shut down club laptop and then turn
it on again. In a way, it’s good that
this happened during our SIG so the
proper reaction can be demonstrated.
Phil Walker asked what to do about a
mouse curser opening things up if
held over a link but not clicked. Bill
went to Control Panel, selected the
mouse icon, and checked the settings. There was nothing that allowed
changing the sensitivity mouse setting, so Bill entered the question in
Google. One of the search engine
results had a link to download and
install a free program called
“Powertoys/TweakUI,” which allows
the mouse sensitivity to be set. Bill
may include this program on the next
WAUC CD of the Month.
And those were some of the issues
dealt with at the October 2011
WAUC Internet SIG.

Richard Durand
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Investment Tracking SIG—Compares
The WAUC Investment SIG met
again on October
26th as scheduled
and was attended
by WAUC members Richard Durand, Don Gardner, Dale Voit, and
we welcomed back Richard's special
guest, Mr. Mike Neumann of Milwaukee. Mike had offered to make a brief
presentation to our SIG about investing and we were happy to accept.
Mike does not have a background in
investing as such, but he intensively
studies biology in general and the
nature of the human brain in particular. Recently he came across a book
about new research on brain activity
during trading and investing. The
book is Your Money and Your Brain
by Jason Zweig; Mike gave us a very
brief summary of the book's findings.
For the purposes of this study, the
brain can be described as having two
parts: the “reflective” brain which
analyzes information, and the
“reflexive” brain which generates
emotions in reaction to the reflective
brain's analyzed information. The
important thing to know about the
reflexive brain is that emotions will be
generated automatically. Research
with MRI (Magnetic Resonance Imaging) brain scans shows that emotional brain activity increases more
with the expectation of investing results than with the actual realized
results. Mike passed around the book
with the pictures of the brain scans to
show us this.
It all goes to explain how otherwise
very intelligent and very educated
and experienced investors can fall
victim to emotions and make very
questionable investing decisions.
That's something we could all relate
to. The lesson is to be aware of how
the brain works to make the emotions
one is experiencing and to pursue
investment methods and strategies
that can use emotions for positive
rather than negative impacts. After
Mike's presentation, we had a lively

discussion and followed up with our
own questions. Since Mike has some
more material on the subject to present, we agreed to invite him back to
our next SIG to finish up.
After this, we made a quick check of
the virtual trading account of our SIG
at www.investopdia.com to see the
latest results. Some of the results
were that Don's choice, ECOL, US
Ecology, was down $1.62, Dale's
choice, ABAT, Advanced Battery,
was down $.10, and Richard's
choice, HDGE, Active Bear ETF, was
down $1.46. Our guest, Mike, had
added his choice to our virtual account, SPY, SPDR S&P 500,at the
previous SIG, and it gained $7.25.
His choice was entered close to the
market bottom for the year and since
then, the market has recovered favorably. In investing, as in comedy,
timing is everything. Besides being a
very useful learning tool, the nice
thing about a virtual account is that
the losses are not in real money.
Our main activity for the SIG was to
watch an investing video together
and this video, almost an hour long,

consumed the remaining time we had
for the evening. This instructional
video is from the training program for
VectorVest, the well known online
trading service. For more information
on VectorVest, go to http://
www.vectorvest.com/.
The video we watched described the
main functional screen used in the
VectorVest system, The Stock
Viewer. VectorVest is a very pricey
subscription service and like most

Gain, Losses

such services, the subscriber has to
log in with a user name and password. Once logged in, one can select
a tab on the VectorVest home page
to go to The Stock Viewer page and
see more mathematical stock information than one might ever want to
know. As previously described in the
WAUC Investment SIG minutes, VectorVest calculates its own rating for
stocks in terms of Relative Value,
Timing, Safety, and other attributes.
These values are all present on this
screen which has the appearance of
a giant spreadsheet or table. With the
power of computer processing, all the
values for as many stocks as desired,
can be sorted any way the user can
think of to find the very best candidates for trading.
A very useful features which was
demonstrated on the video, is the
ability to select stocks based on the
VectorVest values, sort them, and
then back test their price action for a
year or other specified time period
and calculate gains and losses. Not
every stock in the demo was a winner, but you can be sure that it was
set up to show a lot more winners
than losers. The screen also has
fields for each stock giving the VectorVest buy, sell, or hold recommendation, and a stop order amount to
use. There were many more features
described and demonstrated which
can't be reported here because of
space limitations, but we were all
impressed with the breadth and
scope of what can be done for investing with computers. It's not unreasonable to believe that a lot of professionals subscribe to and use VectorVest instead of developing their
own analysis software, and this is the
competition that the individual investor is up against. Sobering.
And that's what we did at the October
WAUC Investment SIG. Until next
time, remember, stocks usually go
higher the way one climbs flights of
stairs, but stocks usually go down the
way one takes the elevator.

Richard Durand
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Word 2010 Paste Features—New
By Lynn Page, Newsletter Editor/
Webmaster
Crystal River Users Group, FL
October 2011 issue, CRUG
newsletter
www.crug.com
editor@crug.com
Those of you who have taken any of
my Word classes or workshops know
I think the Paste Special feature is
one of Word’s most important tools.
We all cut, copy and paste text, images, graphics and other items all of
the time. When working within a single document that is not a problem
but when working with documents
having different formatting or worse
yet web pages it is not as easy. So it
is important to consider how the
pasted items are to be represented.
For text this is more obvious as you
usually want text pasted into a document to conform to the format of that
document. With graphics especially
from the web it can also be a concern. So I have always advocated
using the Paste Special command.

Word 2010 the Paste button in the
Clipboard group provides a better
preview of what happens with the
paste options.
Once a selection has been copied to
paste into a document on the Home
tab click the down arrow under the
Paste button to open the drop down
menu. There are three options:
Keep Source Formatting pastes
the text with the formatting
from the source text has the
same fonts and attributes
that were copied. If images
areincluded they are inserted
with the same vertical and
horizontal spacing.
Merge Formatting pastes the
selection with the formatting
used in the destination Word
2010 document.
Keep Text Only pastes only the
selected text as plain text.
This means any images, hyperlinks and text formatting
are lost. Only plain text will
be pasted so headings, for
example, will lose their size
and bolding.

Word 2010 has added new features
to the Paste command to make it
easier to use Paste and Paste Special.
In Word 2007 a Paste button was
included in the Ribbon but now in

What is really great is the live preview. When you mouse over the icon
in the Paste Options drop down, a

WAUC Membership Application

preview of the pasted selection is
shown in the document. Click on the
icon to select the paste option for
inserting the selection. Moving the
mouse away and moving back into
the document closes the drop down
and nothing is pasted.
Another new feature is that Set Default Paste is included in the Paste
Options. I personally have not felt the
need to change the default paste
settings but it is available through
Word options. To make changes
click Set Default Paste in the Word
Options Advanced features look at
the Cut, Copy and Paste section.
This allows you to change the default
paste option depending on where
you are pasting from. It also has controls for pasting lists and images.
If,like me, you like to cut, copy and
paste by right clicking you can still
access the new features. After making a selection, right clicking on it
opens a new drop down menu. You
still have the expected copy and cut
options but also have the new paste
options.
The new icon-based Paste tool with
live preview makes cutting, copying
and pasting much easier for those of
us that do a lot of moving text and
graphics between documents and
even within applications.
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How did you hear about WAUC?
What do you like to use your computer for?
What talents do you have that you would like to share?

To join WAUC, please send completed form along with check for $25 ($35 is you want to receive WAUCtalk as hardcopy through
the mail) to cover dues from January 1st throughDecember 31, 2012 to:

Wisconsin All-computers Users Club
P.O. Box 340241
Milwaukee, WI 53234-0241

Paid by:
□ Cash
□ Check

□ New Member
□ Renewal
□ Do Not include me in any special mailings.

http://groups.yahoo.com/group/BoardWAUC/
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of their conference room,
please patronize Speedway gas station
at 60th & Layton.
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